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1 Aplicação/Uso Pretendido
• Medição de turbidez relativa de meios líquidos para faixa de turbidez média a alta 

(equivalência de 200 a 300.000 NTU)
• Para uso em aplicações sanitárias das indústrias alimentícias, de bebidas e 

farmacêutica
• Adequado para CIP/SIP em até 140 °C por no máximo 120 minutos
• Inadequado para uso em atmosferas explosivas
• Inadequado para peças de unidades relacionadas à segurança (SIL)

2 Conformidade com as Normas

Os requisitos básicos de segurança e saúde são atendidos através do cumprimento de:
• Compatibilidade Eletromagnética 2014/30/UE
• Portaria 1935/2004/UE sobre Bens de Consumo
• EN 61000-6-2:2005 (Imunidade a Interferências)
• EN 61000-6-4:2007 + A1: 2011 (Emissões de Interferência)

3  Instruções de Segurança

Estas instruções de segurança devem ser seguidas para 

• Evitar colocar em risco as pessoas e o meio ambiente.
• Evitar danos aos sensores.
• Evitar lotes defeituosos durante a produção.

As conexões elétricas só podem ser realizadas por pessoas com as habilidades técnicas 
necessárias (por exemplo, eletricistas certificados ou pessoas com treinamento técnico em 
eletricidade) e por pessoas com a autorização necessária do operador. 

A fonte de alimentação e as entradas e saídas do circuito de controle devem ser instaladas por 
profissionais. Devem ser adquiridas conexões elétricas de última geração. Consulte também a 
Seção 8 “Diagrama da Fiação”.

Os seguintes detalhes devem ser observados em particular:
• Instruções de segurança
• Dados de conexão elétrica

1. Todas as pessoas envolvidas com a instalação, comissionamento, operação, serviço e
manutenção do sensor devem ser adequadamente qualificadas.

2. Este manual de instruções deve ser seguido fielmente. O operador deve garantir que o
pessoal tenha lido e compreendido completamente o manual de instruções.

3. Todo o trabalho deve ser realizado com o máximo cuidado e só pode ser executado por
pessoal autorizado e treinado. Os regulamentos nacionais aplicáveis em relação à
abertura e reparo de dispositivos devem ser cumpridos.

4. Recomendamos armazenar o manual de instruções próximo ao dispositivo de medição em
um local facilmente acessível.

5. O sensor deve ser desligado antes das alterações e manutenção.

6. A área de trabalho do operador deve oferecer espaço suficiente para minimizar o risco de
ferimentos.

7. Os dados técnicos especificados no manual de instruções e nas etiquetas devem ser
observados.

A cobertura da garantia não será concedida por qualquer dano que possa ser atribuído à 
execução inadequada do trabalho no dispositivo.
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6.1  Posição de Montagem 

Notas sobre conexão mecânica/instalação

• O sensor deve ser instalado de forma que a ponta do sensor esteja totalmente 
submerso pelo meio circulante, de modo que nenhuma bolha possa surgir. Portanto, é 
aconselhável instalar dispositivo em tubos ascendentes. Veja os desenhos abaixo 
para referência.

Direção do Fluxo Direção do Fluxo
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6.2 Requisitos de Instalação Higiênica

Dimensões para Instalação Higiênica com Tri-Clamp

Tri-Clamp: T < D Tri-Clamp estendido: T < (D-d)

Posições de montagem recomendadas

ITM-51 no cano vertical ITM-51 no cano horizontal

Condições para instalação higiênica de acordo com a 3A e a EHEDG

• O ITM-51/ITM-51R foi projetado para limpeza CIP/SIP. O sensor pode suportar no 
máximo 140 °C/120 min.

• A posição de montagem deve garantir propriedades de autodrenagem.
• Se montado com uma conexão Tri-Clamp, o “T” de montagem, a posição de 

montagem e a junta precisam seguir as normas e diretrizes da 3A ou EHEDG. 
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Posições de montagem não permitidas usando o Tri-Clamp

A instalação pela parte de cima ou de baixo deve ser evitada com o Tri-Clamp. 
Pode levar a medições incorretas devido ao acúmulo ou depósitos de ar.

6.3 Configuração

O Medidor de Turbidez Relativa ITM-51 está configurado para operar sem a necessidade 
de adaptações especiais. Em casos isolados, alguns parâmetros podem precisar 
ser ajustados. A parametrização pode ser alterada usando o Adaptador de 
Programação MPI-200 acessado via PC, o IO-Link ou a Interface do Usuário 
diretamente no sensor. Isso pode ser realizado diretamente no local ou no laboratório  
em uma simulação a seco.

O sensor é entregue com as seguintes configurações padrão:

Saída Analógica 1 (X45 na conexão do terminal 4 e 5):
turbidez 1 com faixa de medição 0 a 100% TU

Saída do Relé (X67 na conexão do terminal 6 e 7): saída de comutação com ponto de ajuste de 10% TU

A lista de parâmetros que acompanha o sensor contém as configurações do sensor para a saída 
analógica 1 (terminais 4 e 5) em X45a e para a Saída do Relé (terminais 6 e 7) em X67.

O Medidor de Turbidez Relativa ITM-51 apresenta um design modular com uma “estrutura em 
árvore”, que pode ser adaptada para atender aos requisitos e pode ser facilmente trocada em 
caso de falha.

Essa estrutura em árvore é usada pelo software do Adaptador de Programação MPI-200 para o PC e 
para a Interface do Usuário no sensor. O software é subdividido em Visor, Parte Eletrônica 
(interface de sinal) e Sensor (medição de turbidez).

Ao definir os parâmetros, observe que existe uma hierarquia de níveis de autorização (0 - 
Monitoramento, 1 - Ajuste (QuickSetup), 2 - Setup e 3 - Calibração):
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Sensor (medição de turbidez): 
A saída analógica do sensor para turbidez pode ser configurada livremente.

Turbidez: Duas faixas de turbidez diferentes podem ser definidas aqui, independentemente uma 
da outra. O limite de faixa superior pode ser selecionado livremente. A alternância entre as duas 
faixas pode ser feita com o módulo de sinal A53/I53 enquanto estiver usando a entrada de 
comutação digital X3. Esta função não está disponível nos módulos de sinal A42/I42 e A52/I52.

Saída de comutação (aplicável apenas aos componentes eletrônicos A52/I52 e A53/I53): É possível 
selecionar um ponto de ajuste para turbidez, bem como a direção de trabalho da saída de comutação. 

Eletrônica (interface de sinal):

• Seleção de sinal para o sinal de 4 a 20 mA: Seleção entre Turbidez 1 ou 2 e a categoria de 
turbidez aplicável

• Definição do valor para o sinal de 4 ou 20 mA: Por padrão, o limite de faixa inferior é usado 
para o sinal de 4 mA e o limite de faixa superior para o sinal de 20mA. Isso pode ser ajustado 
conforme necessário.

• Sinal de aviso “No Media”: Sinal de corrente fechada quando o sensor não está imerso em um 
funcionamento medium → dry.

• Sinal de aviso “Outside Spec”: Sinal de corrente fechada se um estado operacional estiver 
fora da faixa especificada. A precisão da medição não pode mais ser garantida.

• Sinal de erro “Global Failure”: Sinal de corrente fechada se ocorrer um mau funcionamento, 
por exemplo, se o dispositivo falhar.

• Limite de sinal para subfaixa e sobrefaixa: Limite inferior ou superior do sinal de corrente 
fechada que ainda é válido e linear quando emitido abaixo de 4 mA ou acima de 20 mA.

• Sinal de erro “Underflow/Overflow”: O sinal de corrente fechada está abaixo ou acima do 
limite inferior ou inferior.

• Simulação de sinalização: Simula o sinal de corrente fechada, em que o valor-fonte é 
substituído brevemente pelo valor do parâmetro inserido.

• Configuração de LED: Esses dois LEDs podem ser configurados conforme necessário. O 
procedimento é descrito na Seção 6.2.2. 

Uma lista dos parâmetros definidos no sensor de turbidez é inclusa na entrega. Esses valores de 
parâmetros, bem como os alterados pelos próprios usuários, podem ser impressos usando o 

Adaptador de Programação MPI-200 através do caminho File → Parameter Data → Print e também 
podem ser exportados como um arquivo para o PC (através do caminho File → Parameter Data → 
Export Data File (*.xml)).

Ao fazer as configurações, observe os textos de ajuda no software MPI para cada parâmetro. Eles 
fornecem informações úteis sobre como alterar o parâmetro selecionado.

6.4 Configurações usando o Adaptador de Programação MPI-200

O Adaptador de Programação MPI-200 é conectado ao Medidor de Turbidez ITM-51 através da 
peça externa do adaptador MPI-200-F. Deve-se garantir que o Medidor de Turbidez ITM-51 esteja 
permanentemente conectado à fonte de alimentação enquanto os parâmetros estiverem sendo 
definidos.
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Depois que o sensor for conectado ao PC e o software do usuário for aberto, a seguinte janela 
aparece:

1. Informações sobre o valor atual do processo
2. Botões para alterar a configuração do parâmetro
3. Informações sobre o valor-fonte da corrente
4. Parâmetros ajustáveis do PC
5. Parâmetros ajustáveis do sensor

Clicar no + no menu abre um submenu onde os 
parâmetros podem ser ajustados.

Nota:  
Para outras configurações, consulte também a descrição nas informações do produto MPI-200.

Para definir ou alterar parâmetros diretamente no sensor (consulte a seção 6.2 “Configurações 
usando a Interface do Usuário”), você precisa dos códigos ID contidos na tabela abaixo. Esta 
tabela lista apenas os códigos ID mais importantes.

5. 

Plug de conexão para o Adaptador 
MPI-200-F como um plug intermediário 
entre o sistema eletrônico do ITM-51 e 
a conexão MPI-200 3 (veja a próxima 
figura)

3 

1: Inoperante

2: Porta USB para conectar a um PC 

3: Cabo de conexão no adaptador para o Sensor 

Conexão do Adaptador de Programação MPI-200

1 

2 3 

1. 

2. 

3. 

4.
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Outros códigos ID podem ser encontrados no Software do Usuário. Para visualizá-los, clique com 
o botão direito do mouse em “Info” pelo nome do parâmetro. Uma caixa de informações aparece 
com o respectivo ID (veja o gráfico abaixo):

Como o número da pesquisa deve ter 6 dígitos, sempre é adicionado um dígito a mais na frente do ID 
de cinco dígitos (30034 no gráfico acima). Esse dígito depende do nodo da seguinte maneira:

4 para alterações no visor
3 para alterações na interface de sinal
0 para alterações na medição de turbidez

Como a seleção de sinal está localizada no nodo da interface única, o código ID para o exemplo 
“Signal selection” acima é: 330034. 

Uma lista de todos os códigos ID pode ser impressa através da Interface do Usuário do PC. Para 

fazer isso, clique em File → Parameter Data → Print para abrir a janela correspondente e 
imprimir a lista completa de códigos ID.

Lista de códigos ID importantes:

Nome do Parâmetro/
Parâmetro 

Modo de Acesso /
Setup 

N° de Pesquisa 

(ID) 
Nome do Valor 

Sensor 

Unit Turb1 Setup 014021 Turbidity1 

Damping 1 Setup 014027 Turbidity1 

Range Tb.1 Setup 014029 Turbidity1 

Unit Turb1 Setup 014022 Turbidity2 

Damping 1 Setup 014028 Turbidity2 

Range Tb.1 Setup 014030 Turbidity2 

X-Pnt 01 Setup 013151 Tu.%Solids 

Y-Pnt 01 Setup 013171 Tu.%Solids 



Manual de Instruções ITM-51/ITM-51R 10 

Thru Setup Thru Tu.%Solids 

X-Pnt 08 Setup 013158 Tu.%Solids 

Y-Pnt 08 Setup 013178 Tu.%Solids 

Sinal de Corrente Fechada 1
 

Signal Selection Setup 330031 X45a I-Out 

Underrange Limit Setup 330141 X45a I-Out 

Overrange Limit Setup 330211 X45a I-Out 

no Media= Setup 330121 X45a I-Out 

Out Spec.= Setup 330221 X45a I-Out 

Underflow= Setup 330151 X45a I-Out 

Overflow= Setup 330161 X45a I-Out 

Failure= Setup 330131 X45a I-Out 

Simulation Setup 330201 X45a I-Out 

Entrada Digital

Direction Setup 330821 Digital-In 

Simul. Inp Setup 330831 Digital-In 

Sinal de Corrente Fechada 2 

Signal Selection Setup 330032 X45b I-Out 

Underrange Limit Setup 330142 X45b I-Out 

Overrange Limit Setup 330212 X45b I-Out 

no Media= Setup 330122 X45b I-Out 

Out Spec.= Setup 330222 X45b I-Out 

Underflow= Setup 330152 X45b I-Out 

Overflow= Setup 330162 X45b I-Out 

Failure= Setup 330132 X45b I-Out 

Simulation Setup 330202 X45b I-Out 
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Saída Digital

Signal Selection Setup 330037 X67 D-Out 

Function Setup 331114 X67 D-Out 

Direction Setup 331124 X67 D-Out 

Inp.  Method Setup 331114 X67 D-Out 

Switch Pt. Setup 331144 X67 D-Out 

Hysteresis Setup 331254 X67 D-Out 

ON Delay Setup 331174 X67 D-Out 

OFF Delay Setup 331114 X67 D-Out 

No Media= Setup 331194 X67 D-Out 

Out Spec.= Setup 331204 X67 D-Out 

Underflow= Setup 331214 X67 D-Out 

Overflow= Setup 331224 X67 D-Out 

Failure= Setup 331234 X67 D-Out 

Simulation Setup 331244 X67 D-Out 

Visor 

Language Setup 451010 Set Display 

Contrast Setup 451020 Set Display 

Scrs delay Setup 451050 Set Display 

Password Setup 450103 Set Display 

6.5  Configurações usando a Interface do Usuário

A estrutura do software da Interface do Usuário é semelhante à versão do software para PC. 
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O sistema é operado usando dois botões de controle à esquerda e à direita do visor. Esses dois 
botões podem ser usados para navegar pela estrutura em árvore da Interface do Usuário para 
alterar os parâmetros. As funções dos botões são as seguintes: 

Notas sobre a configuração usando um número ID

1) Pressione e segure o botão direito, o visor vai para o menu.
2) Pressione a tecla direita 2x rapidamente para a posição “ID Search”.
3) Pressione e segure a tecla direita e selecione o item desejado “ID Search”
4) Pressione e segure a tecla direita e digite o número de ID da direita para a esquerda.  

Proceda da seguinte forma:

a) Selecione a posição desejada (navegação com direita/esquerda - pressione a tecla esquerda): Altere 
a posição para a esquerda, pressione a tecla direita, altere a posição para a direita.)

b) Pressione e segure a tecla direita na posição desejada até que o campo seja destacado em cinza, 
depois insira o valor numérico com as teclas direita/esquerda e confirme com a tecla direita por um 
longo tempo até que o número não seja mais armazenado. Em seguida, insira o próximo dígito.

c) Quando todos os dígitos tiverem sido inseridos, pressione a tecla esquerda ou direita até que todos 
os dígitos sejam destacados em cinza.

d) Em seguida, pressione e segure a tecla direita. O sistema então pula para o parâmetro selecionado, 
que agora pode ser inserido/alterado da mesma maneira. Comece aqui novamente, pressione e 
segure o botão direito.

e) Para alguns parâmetros relevantes do sistema, um prompt de confirmação aparecerá perguntando se 
a alteração deve ser salva ou não. 

5) A entrada pode ser abortada pressionando e segurando o botão esquerdo. A configuração pode 
ser cancelada pressionando e segurando o botão esquerdo várias vezes. 

• Pressionar o botão direito significa que o parâmetro foi alterado ou salvo.
• Pressionar o botão esquerdo significa sair da configuração sem alterá-la. 

6.5.1 Tela

Depois que os parâmetros do sensor foram adaptados/alterados, ou depois que o sensor foi 
ligado e nenhuma alteração foi feita, o sensor muda para o modo de exibição após um certo 
período. No modo de exibição, o valor de medição principal é mostrado como descrito na figura 
abaixo. Se uma segunda opção de saída estiver disponível (apenas para as versões eletrônicas 
A52 e A53), o valor real será mostrado na linha inferior do visor.

Botão Pressionar rapidamente Pressionar e segurar

R Pula para o próximo parâmetro Edita um nodo/parâmetro

L Volta para o nodo/parâmetro anterior Deixa modo de edição sem salvar, volta para o 
próximo nível superior

R/L Desliza para cima e para baixo
R e L 

juntos
Pressione os dois botões por 10 segundos: o menu volta ao 
início (atenção: não é uma restauração)

R Direito

L Esquerdo



Manual de Instruções ITM-51/ITM-51R 13 

Para sair do modo de exibição e criar configurações no sensor, pressione o botão direito ao lado 
da tela duas vezes para entrar no menu. O sensor exibe a página inicial, onde as configurações 
podem ser criadas.

6.5.2 Configuração de LED

A unidade de exibição possui 2 LEDs que podem ser configurados individualmente. O LED à 
esquerda da tela é o LED 1, enquanto o da direita é o LED 2.  

As seguintes opções podem ser selecionadas ao definir os LEDs:

• Seleção de Sinal: Os seguintes sinais podem ser selecionados: turbidity 1 e 2.
• Função de saída, direção da ação, método de entrada do ponto de comutação, ponto de comutação e 

histerese
• Interruptor ON Delay, Interruptor OFF Delay: A saída digital é ligada ou desligada com o delay definido aqui. 

Os valores podem ser definidos entre 0 e 30 s.
• Warn-S: sem mídia, Warn-S: Fora da especificação, Err-Sig: Subfluxo, Err-Sig: Transbordamento, Err-Sig: 

falha geral: O efeito de cada parâmetro no visor de LED pode ser definido. É possível selecionar os seguintes 
itens: “No Effect on Output”, “Output Fast Blinking” (intervalo de 0,4 s), “Output Slowly Blinking” (intervalo 
de 1 s), “Output ON” (LED aceso continuamente) e “Output OFF”. "Output” se refere ao LED aqui.

• Simulação de Sinalização: O valor-fonte é substituído brevemente pelo valor do parâmetro inserido. As 
seguintes situações podem ser simuladas: “Output OFF”, “Output ON”, “Output Slowly Blinking” e “Output 
flashes rapidly”. “Output” se refere ao LED aqui. 

O sensor de turbidez é fornecido com as seguintes configurações de fábrica para os LEDs:

• LED 1 (LED esquerdo)
Se o sensor estiver em um estado normal, este LED estará apagado.
Err-Sig: Overflow: O LED pisca a cada segundo se o sensor registrar um erro de sobrefaixa. Se 
o sensor estiver em um estado normal, este LED estará apagado.
Err-Sig: Temperature Error: O LED fica aceso permanentemente se o sensor registrar uma 
temperatura média acima de 130 °C permanente.
Todos os outros erros são indicados enquanto o LED pisca em intervalos curtos.

• LED 2 (LED direito)
Condição da saída de comutação: O LED acende continuamente se a faixa de turbidez 
predefinida for atingida. A direção de trabalho da saída de comutação e, portanto, o 
comportamento do LED podem ser alterados. 

6.6 Exemplos de Configurações do Sensor

Vários exemplos de configurações que podem ser criadas na Interface do Usuário ou na Interface 
do Usuário do PC podem ser vistos abaixo.

Nome do valorValor medido 
atualmente na saída 
da corrente

Unidade de medição

A linha inferior é usada para exibir a segunda saída, se 
disponível.



Manual de Instruções ITM-51/ITM-51R 14 

6.6.1 Estrutura do Menu Interface do Usuário 

Calibr. Calibr. Calibr. Calibr.

Display

Calibr.

Us1-Slope

Us2-Slope

X45a 4mA

X45a 20mA

X45b 4mA

Menu

QuickSetup

Setup

ID Search

Calibration

Us1-Offset

Us2-Offset

X45b 20mA

X67 4mA

X67 20mA

X67 D-Out

X45a I-Out

Digital-In

X45b I-Out

Turbidity1

Turbidity2

Tu. %Solids

Setup

Sensor

Display

Contrast

Menu Menu

ID Search

QuickSetup

Menu

Range Tb.2

Language

LED2 D-Out

Set Displ.

LED1 D-Out

Sensor

Quick Setup Setup ITM51

Unit Turb2 Display

Range Tb.1 000000

Setup Setup Setup Setup

Menu

QuickSetup QuickSetup QuickSetup

ID-Search

ID Search ID Search ID Search

Unit Turb1 Sensor

R

R la. R la.

R

R la.

R R

R la.

R la.

R

R la.
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6.6.2 Exemplo de Configuração da Faixa de Turbidez 1 sem um Código ID: 

Alternativa para inserir a faixa de medição conforme descrito acima, a faixa de medição também pode 
ser ajustada digitando um Código ID. 

Para fazer isso, vá para “SIM” na página de pesquisa de ID e insira o código ID usando os botões. Após 
a confirmação do código, a tela do sensor mostra o menu no qual o parâmetro pode ser ajustado.

Calibr.

100.00

200.00

200.00

200.00

Save Data?

No / Yes

Menu

100.00

ITM51

Turbidity1

x.xx %TU

Turbidity 1

Range Tb.1

last step

for all

digits

Repeat the

ID: 014030

x.xx %TU

ID: 014030

Range Tb.1

Turbidity 1

x.xx %TU

ID: 014030

Range Tb.1

ID: 014030

Turbidity 1

x.xx %TU

Turbidity 1

Range Tb.1

Turbidity 1

x.xx %TU

ID: 014030

Range Tb.1

x.xx %TU

ID: 014030

Unit Turb1

Unit Turb2

Turbidity 1

Quick Setup

Unit Turb1

Unit Turb2

Range Tb.1

Quick Setup

Range Tb.1

Range Tb.1

Turbidity 1

x.xx %TU

QuickSetup

Setup

ID Search

x.xx %TU

ID: 014030

100.00 %TU

100.00

Range Tb.1

R la.

R 

R la.

R

R la.

R/L

R la.

R la.

R

R la.

R la.

R la.

Usando os botões esquerdo 
e direito, navegue até o 
parâmetro a ser ajustado e 
defina o valor necessário.
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6.6.3 Configuração da Turbidez Específica do Cliente / % da Curva de Sólidos via Software do PC

Depois que o software do PC for iniciado, uma curva específica do cliente para a turbidez pode ser inserida 

através do seguinte nodo: Medição da Turbidez →% de sólidos → (+). É necessário inserir valores para pelo 

menos 2 pontos X e Y. Até 8 pontos de suporte para X e os valores Y associados podem ser inseridos para 

estabelecer a relação entre turbidez (X) e % de sólidos (Y). Os valores Y, juntamente com os valores X 

associados, formam coordenadas que atuam como pontos de suporte para a curva de linearização. Se 0 for 

inserido para qualquer um desses pontos, esse ponto de suporte será desativado.

Ponto X 01 ao Ponto X 08 (Turbidez): Este parâmetro é usado para definir a faixa de medição específica do 
cliente para a turbidez. Os valores podem ser inseridos de 0 a 300 kNTU.

Ponto Y 01 ao Ponto Y 08 (% de sólidos): Este parâmetro é usado para definir a faixa de medição específica 
do cliente. Os valores podem ser inseridos de 0 a 100%.
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7 Instalação da “Interface Grande do Usuário” (LUI)

1. Remova a tampa plástica (continue no passo 4) ou remova o disco com o visor pequeno montado 
(continue na etapa 2)

2. Remova o visor pequeno
3. Instale o disco no cabeçote do sensor
4. Monte o visor grande 

Função hot-plug: O visor grande pode ser instalado enquanto o sensor estiver ligado, mas isso 
requer as medidas de precaução habituais ao trabalhar com componentes eletrônicos. 

Se o visor estiver sendo instalado enquanto estiver ligado, é necessário pressionar os dois 
botões simultaneamente por > 10 s após a instalação do visor para ativá-lo.

7.1 Reconfigurando o visor se um visor ainda não estiver instalado

Após remover a tampa plástica, o visor grande pode ser inserido no cabeçote do sensor. As abas 
(Fig. 2) devem ser inseridas nas aberturas apropriadas no disco (Fig. 1). Em seguida, o visor pode 
ser facilmente pressionado no disco. Nenhuma fiação é necessária.

Nota: Após a montagem da Interface Grande do Usuário, o sensor só pode ser operado neste visor, 
pois oculta o conector do Adaptador MPI-200. Se preferir operar o sensor usando o software de 
programação, o visor deve ser removido. Em seguida, o conector do Adaptador de Programação 
pode ser conectado.

Fig. 1 Fig. 2 Fig. 3 

Atenção: O conector do Adaptador de Programação (Fig. 3) deve ser conectado na direção correta 

→ o espaçador verde deve estar voltado para a saída do cabo (Conector M12 ou PG).

Remova a tampa plástica: Para fazer isso, dobre as 
abas levemente para dentro com uma chave de 
fenda para poder remover a tampa facilmente.
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7.2 Reconfigurando o visor se um visor pequeno (SUI) já estiver instalado

Primeiro, o disco com o visor montado precisa ser removido usando a ferramenta extratora de disco 
(Fig. 1). Para fazer isso, desconecte os fios do terminal de cabos. Em seguida, insira os cinco braços do 
extrator de disco nas abas plásticas do disco (Fig. 2).

Empurre o extrator de disco totalmente para dentro do 
cabeçote do sensor e empurre o disco o mais longe possível 
em direção ao cabeçote do sensor, de modo que os braços do 
extrator de disco segurem firmemente o disco.
Puxe o disco com o visor para fora da carcaça do sensor e, 
finalmente, retire o visor pequeno do disco.

Agora, o disco sem o visor pode ser adequadamente posicionado e instalado de volta no cabeçote do 

sensor e a fiação pode ser reconectada ao terminal de cabos. Em seguida, o visor grande pode ser 

montado → ver “Reconfigurando o visor se um visor ainda não estiver instalado”.

7.3 Operando o Visor Grande

O visor grande (LUI) é operado da mesma maneira que o visor pequeno (SUI). É operado usando dois 
botões operacionais abaixo da tela:

Depois que o sensor for iniciado, a proteção de tela aparece, na qual os valores do processo do 
sensor são exibidos um após o outro. Para acessar a página inicial a partir daqui, pressione um dos 
dois botões rapidamente.

Fig. 4 Fig. 5 
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8 Dimensões 

ITM-51 com orientação vertical do cabeçote.

Conexão do Processo

SOL  TCx  TLx  Vxx  

Tamanho 
do TriClamp

Tamanho 
do Varivent

Tipo Ø A Tipo Ø A Ø B 

TC1 / TL1 50,5 mm V25 66,00 mm 57,00 mm 

TC2 / TL2 64,00 mm V40 84,00 mm 75,00 mm 

T25 / TL5 77,50 mm 

TC3 / TL3 91,00 mm 
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ITM-51 com orientação horizontal do cabeçote.

Conexão do Processo        

SOL  TCx    TLx Vxx 
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9 Módulos de Sinal Analógico de Conexão Elétrica

9.1 Bloco de Terminais da Série A5x 

X A52 A53 

X1 Fonte de Alimentação  + 

X2 Fonte de Alimentação  - 

X3 Não atribuído Entrada Digital X3

X4 Saída Analógica X45 + 

X5 Saída Analógica X45 - 

X6 Saída do Relé 67 

X7 Saída do Relé 67 

9.2 Bloco de Terminais da Série A4x 

X A42 

X1 Fonte de energia +

X2 Fonte de energia -

X3 Não atribuído

X4 Saída Analógica X45 +

X5 Saída Analógica X45 -

9.3 Cor dos Cabos do Conector M12 

Conector M12 Pin Cor padrão Cor da Anderson
1 Marrom Vermelho 

2 Branco Preto
3 Azul Verde
4 Preto Não atribuído

5 Cinza Branco
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9.4 Conector M12 da Série A5x 

Conexão Elétrica “N”

Conector M12 Módulo de Sinal

Conector Pin A52 A53 X 

1 Saída Analógica X45 +
Saída do Relé X67
Saída do Relé X67

Saída Analógica X45 -
Fonte de Alimentação +

Não atribuído
Não atribuído

Fonte de Alimentação -

X4 

2 X6 

3 X7 

4 X5 

1 X1 

2 - 

3 - 

4 X2 

5 Não atribuído Entrada Digital X3 X3 

Conexão Elétrica “A”

Conector M12 Módulo de Sinal

Conector Pin A52 A53 X 

1 Saída Analógica X45 -
Saída Analógica X45 +

Fonte de alimentação +
Fonte de alimentação -

Saída do Relé X67
Não atribuído
Não atribuído

Saída do Relé X67

X5 

2 X4 

3 X1 

4 X2 

1 X6 

2 - 

3 - 

4 X7 

5 Não atribuído Entrada Digital X3 X3 

9.5 Conector M12 da Série A4x 

M12 Connector Conexão Elétrica “M”

Conector Pin Módulo de Sinal A42 X 

1 Fonte de Alimentação +
Saída Analógica X45 +
Saída Analógica X45 -

Fonte de Alimentação -

X1 

2 X4 

3 X5 

4 X2 
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10 Módulos de Sinal Digital de Conexão Elétrica

10.1 Bloco de Terminais da Série I5x 

X A52 A53 

X1 Fonte de Alimentação +

X2 Fonte de Alimentação -

X3 IO-Link 
IO-Link /  

Digital Input X3 

X4 Saída Analógica X45 +

X5 Saída Analógica X45 -

X6 Saída do Relé 67

X7 Saída do Relé 67

10.2  Bloco de Terminais da Série I4x 

X I42 

X1 Fonte de Alimentação +

Fonte de Alimentação -

IO-Link

Saída Analógica X45 +

Saída Analógica X45 -

X2 

X3 

X4 

X5 

10.3  Cor dos Cabos do Conector M12 

Conector M12 Pin Cor padrão Cor da Anderson
1 Marrom Vermelho
2 Branco Preto 

3 Azul Verde  

4 Preto Não atribuído

5 Cinza Branco
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10.4  Conector M12 da Série I5x 

Conexão elétrica “R”

Conector M12 Módulo de Sinal

Conector Pin A52 A53 

1 Saída Analógica X45 +
2 Saída do Relé X67
3 Saída do Relé X67
4 Saída Analógica X45 -

1 Fonte de alimentação +

3 Fonte de alimentação -

4 IO-Link 
IO-Link /  Entrada 

Digital X3 

10.5  Conector M12 da Série I4x 

Conector M12 Conexão elétrica “C”

Conector Pin Módulo de Sinal I42 X 

1 Fonte de Alimentação +
Saída Analógica X45 -

Fonte de Alimentação -
IO-Link

Saída Analógica X45 +

X1 

2 X5 

3 X2 

4 X3 

5 X4 
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11 Identificação do Dispositivo ITM-51 IO-Link

12 Dados do Processo ITM-51 IO-Link
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13 Reparo e Manutenção

O sensor de turbidez descrito aqui é livre de manutenção. No entanto, é recomendável 
verificar a calibração do sensor de turbidez uma vez por ano. Para esta verificação, recomenda-
se a ferramenta de verificação de calibração ITM-51-CU.

Referência cerâmica

Tampa ITM-51-CU Fundo ITM-51-CU ITM-51-V40 colocado no 
ITM-51CU 

A unidade ITM-51-CU é usada da seguinte forma:

1. Limpe a lente. A lente deve estar livre de resíduos e arranhões.
2. Altere a categoria de medição para NTU
3. Configure o limite de faixa superior para 300 kNTU
4. Coloque a placa de referência cerâmica na peça inferior de acordo com a conexão do 

processo ITM-51. Os tipos de conexão TLx e Sox são colocados de baixo e centralizados 
automaticamente. Os tipos de conexão TCx e Vxx são colocados na parte superior, como 
mostra o desenho acima. A centralização é feita ao enroscar a tampa na peça inferior.

5. Verifique o valor NTU exibido e compare com o valor de referência impresso na etiqueta do 
ITM-51-CU. O valor também deve estar dentro da faixa de ± 6%, conforme impresso na 
etiqueta.

6. Se o valor exibido estiver fora dos limites, é recomendável enviar o ITM-51 para 
recalibração. 



Manual de Instruções ITM-51/ITM-51R 27 

14 Dados Técnicos

Categoria de 
medição

A categoria de medição 
pode ser selecionada

%TU, NTU, EBC, %sólidos (personalizada) 

Faixa de medição A faixa de medição é 
livremente ajustável

0…300.000 NTU 

0…200 %TU 

0…75.000 EBC 

Conexão do Processo CLEANadapt G1/2" higiênica  

Tri-Clamp 1.5", 2", 2.5", 3" 

Varivent DN 25 (tipo F)
DN 40/50 (tipo N)

Pressão do processo -1…20 bar

Torque de aperto 20 Nm (Sistema CLEANadapt) 

Materiais Cabeçote de conexão

Sensor

Lente

Tampa de plástico/visor

Aço inoxidável 1.4308 (CF-8)

Aço inoxidável 1.4404 (316L) 

Safira

Policarbonato

Faixas de temperatura Ambiente

Processo 

CIP/SIP

-10…60°C

-10…130°C

Até 140°C máx. 120 min

Reprodutibilidade de turbidez < 1% do limite de faixa superior

Faixa de resolução/
medição

a resolução depende da 
faixa de medição 
selecionada

faixa/ NTU 

< 1 000 

1 000…10000 

10000…100000 

resolução/ NTU 

15 

30 

100 

Precisão 0…9.999 NTU 

10.000…300.000 NTU 

± 3% do valor da medição;
Deslocamento de ± 50 NTU

±5% do valor da medição

Estabilidade de longa duração ±0,2 % do valor de medição

Tempo de resposta para medição de 
turbidez

0,75 s 

Princípio de medição retroespalhamento infravermelho Comprimento de onda 860 nm

Conexão elétrica Prensa-cabos

Cabo de Conexão

Fonte de alimentação

2 x M16 x 1.5 

2 x Conector M12 1.4305 

18…36 V DC máx. 190 mA 
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Classe de proteção IP 69K 

Saída Analógica 

Digital 

1x saída analógica 4...20 mA, sem potencial 
[sic], 1x Saída de Relé sem potencial [sic]

1x entrada digital (24 VCC), à prova de 
curto-circuito

IO-Link v1.1 

Peso 750 g 

Negele Messtechnik GmbH | Raiffeisenweg 7 | 87743 Egg an der Guenz | Alemanha | Fone: +49 83 33 . 92 04 – 0 | Fax: +49 83 33 . 92 04 - 49 
Anderson Instrument Company Inc. | 156 Auriesville Road | Fultonville, NY 12072 | Fone: +1 518-922-5315 | Fax: +1 518-922-8997 
Anderson-Negele | Avenida Tamboré, 1077 | Tamboré - Barueri - São Paulo - Brasil | Fone +55 11 3616-0150




